I. ATTACHMENT F

ACCESSING THE FCC NETWORK
USING WINDOWS 95/98

This attachment describes how to access the FCC Network from a system that is running the
Microsoft Windows 95 or 98 operating system. This involves configuring dial-up network access
and then performing the dial-up procedure.

This attachment describes two methods to establish a remote connection to the FCC Network for
both Auction 33 and the Mock Auction:

e The sections title@uick-Start for FCC Auction 3andQuick-Start for Mock Auctiordescribe
connection procedures that use standard default values to configure the dial-up networking
software. Specifically, the programs used by these procedures assume that you have a
standard 56K modem and that you must diad reach an outside line.

e If you need something other than the standard defaults, you can use the more complete
method for configuring and starting the dial-up software that is described Qogietete
Method for Connecting to the FCC Network

This attachment also provides sections describingbleshootingandHelp.

Conventions
The instructions in this section use the following typographical conventions:

bold Represents objects on the screen that you click with the mouse pointer, including
buttons, Internet links, icons, tabs, menu items (€ancelbutton,Auctions
link, Saveoption in the File menu).

italic Represents field names or areas of a screen Ag@plicantfield, Selected
Licensesarea of a screen).

bold italic Represents characters that you must type exactly as they appear in the
instructions. For example, if you are instructed to tyje://wtbwww03.fcc.gov
you should type all of the characters shown in bold italic exactly as they are
printed.

SMALL CAPS Represents keys on the keyboard (e.§yTER, CTRL, ESQO).

Note: Throughout these instructions, “enter” means to type the appropriate information and then
press the ETER key.
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A. Quick-Start for FCC Auction 33

Important: Disable any screen saver software before performing the following
procedure.

Note: The following procedure connects to the FCC Network through a 900 number
telephone service. The first minute of connection time to the 900 number service is at no
charge, but there is a charge of $2.30 per minute for all subsequent connection time.
To establish a remote connection to the FCC Network, do the following:
1. Click the Windows 95/9&tart button.
2. Click thePrograms option.
3. On the Programs menu, click tR€C Remote Bidding Softwareoption.
4. Click Auction 33 Dial-Up Connection
The system checks to ensure that your computer has all components necessary to establish a
dial-up connection. If a required component is missing, the system invokes Windows to help
you set up the component.
5. When the system has verified that all necessary components are present, a dialog appears with
instructions on how to establish the dial-up connection. Read these instructions, then click the

OK button.

6. When the dial-up connection window appears, cickinectto connect to the FCC
Network.

Note that the system has also placed an icon laBeletion 33 Dial-Up Connectionon your

desktop. To establish a dial-up connection in the future, you can double-click this icon instead of
performing the preceding steps.

B. Quick-Start for Mock Auction

Important: Disable any screen saver software before performing the following
procedure.

To establish a remote connection to the FCC Network, do the following:
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1. Click the Windows 95/9&tart button.

2. Click thePrograms option.

3. On the Programs menu, click tREC Remote Bidding Softwareoption.

4. Click Mock 33 Dial-Up Connection
The system checks to ensure that your computer has all components necessary to establish a
dial-up connection. If a required component is missing, the system invokes Windows to help
you set up the component.

5. When the system has verified that all necessary components are present, a dialog appears with
instructions on how to establish the dial-up connection. Read these instructions, then click the

OK button.

6. When the dial-up connection window appears, dcickinectto connect to the FCC
Network.

Note that the system has also placed an icon labétet 33 Dial-Up Connectionon your

desktop. To establish a dial-up connection in the future, you can double-click this icon instead of
performing the preceding steps.

C. If You Have Trouble Establishing the Connection

If you are have trouble making the connection, two things may have to be changed:

e The connection automatically precedes the phone number that is to be diaed Mvitbu
need a digit other than 9 to reach an outside line, or no digit is neededi|l y@avevto
change the settings in the connection.
To make this change, double-click the connection icon, theniakProperties. You will
see tha® precedes the phone numbers on all calls, both local and long-distance. Change this
digit to what you need to get an outside line, or delet®,tliappropriate. Clickpply and
thenOK.

e The connection is set up for a standard 56K modem. If you are using some other kind of
modem, you must change this setting.

To access dial-up networking:

1. Click the Windows 95/9&tart button.
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2. Click thePrograms option.
3. On the Programs menu, click tAecessorieoption.

4. In Windows 95, clickDial-Up Networking. In Windows 98, clickCommunications
thenDial-Up Networking.

5. When you see the icon for dial-up networking that was created for you, right-click it
and selecProperties.

You will be in the General tab and you will see the standard default modem selected.

6. Select your modem from the drop-down menu and then ©kk
D. Complete Method for Connecting to the FCC Network

This section describes how to configure both the FCC Mock Bidding Software and the FCC
Remote Bidding Software for dial-up networking. Then it describes how to use the configured
software to establish a connection to the FCC Network.

1. Configuring Dial-Up Networking

Important: Disable any screen saver software before performing the following

procedure.
1. To start dial-up networking:
a. Click the Windows 95/98tart button.
b. Click thePrograms option to display the Programs menu.
C. Click theAccessorieption to display the Accessories menu.
d. In Windows 95, clickDial-Up Networking.

In Windows 98, clickCommunications, thenDial-Up Networking.

If Dial-Up Networking is not an option on your Accessories menu, you should install it
from your Windows 95/98 CD or diskettes.

2. When the Dial-Up Networking window appears, double-clickitag&e New Connection
icon.

The Make New Connection window appears.

3. If you are connecting to the FCC Network during the Mock Auction, Bg@ Auctions
F-4



10.

11.

800#in the field titledTypea name for the computer you are dialing

If you are connecting to test your connection on the 900# tidtevwwsed during Auction

33, typeFCC Auctions 9004n the field titledType a name for the computer you are

dialing.
Note: If you connect to the FCC’s 900# telephone service, there is a charge of
$2.30 per minute. The first minute of connection time to the 900 number service is
at no charge.

In Windows 95, click the down arrow at the right of 8edect a modeifield and select
your modem from the menu of available modems.

In Windows 98, click the down arrow at the right of 8elect a devicéeld and select
your modem from the menu of available devices.

If your modem does not appear on this list, you must install your modem driver according
to the modem manufacturer installation procedures, which are usually described in your
modem’s user manual.

Click theNext button.

If you are connecting to the FCC Network during the Mock Auction, 80&and378-
7435in theArea CodeandTelephone Numbdields, respectively.

If you wish to test your connection on the 900# thiitbe used during Auction 33, type
900and555-5335in theArea CodeandTelephone Numbdields, respectively.

Verify that the correct country is selected in @@ntry coddield.

If necessary, click the down arrow at the right of@oegintry coddield and select the
appropriate country from the menu of available countries.

Click theNext button.
Click theFinish button.

An icon labeled eithefCC Auctions 800#r FCC Auctions 900#ppears in the Dial-Up
Networking window.

Verify that properties are configured correctly before attempting a dial-up session. Put
the mouse pointer on the FCC Auctions icon that you wish to configure and cligghthe
mouse button to display a menu. Cliefoperties from the menu.

Click theConfigure button. Click theDptions tab at the top of the Properties window.
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12.

13.

14.

15.

16.

17.

18.

19.

20.

In theConnection controhrea of the Options tab, verify thaitheroption is selected. If
either option is selected, click the check box at the left of the option to deselect it. Then
click OK.

In Windows 95, click th&erver Type...button.

In Windows 98, click th&erver Typestab at the top of the Properties window.

In theAdvanced Optionarea, verify that onliznable softwareompressionis selected.

If it is not selected, click the check box at the left of the option to select it. If either of the
other options is selected, click the check box to deselect it.

In theAllowed NetworkProtocolsarea, verify that only CP/IPis selected.

If it is not selected, click the check box at the left of the option to select it. If either of the
other options is selected, click the check box to deselect it.

Click theTCP/IP Settingsbutton and sele@pecify name server addresses
Type 165.135.241.148s the Primary DNS arib65.135.79.9%s the Secondary DNS.

At the bottom of the TCP/IP Settings window, ensure ttisg IP Header Compression
andUse Default Gatewagn the Remote Network options are selected.

Click OK on the TCP/IP Settings window and the Server Type window.

a. Click the Windows 95/98tartbutton, then click th&ettingsoption to display
the Settings menu.

b. ClickControl Panel and then double-click thgetwork icon.

c. Highlight theTCP/IP Protocoland clickProperties. If there are multiple TCP/IP
protocols, highlighfTrCP/IP --> Dial-Up Adapterand clickProperties.

d. Click theDNS Configuration tab.

e. Typebidderin theHostbox and typdcc.govin theDomainbox.
Note: You are limited to three DNS entries. If you already have three DNS entries,
you must delete two of them before performing the next two steps. To do this, click

the first entry you want to delete and click &emovebutton. Then click the second
entry you want to delete and click tRemovebutton again.
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f. Typel65.135.241.14% the DNS Server Search Order box and clickAtid button.
g. Typel65.135.79.9%n the DNS Server Search Order box and dlidkl again.

h. Click OK on the TCP/IP Properties windows, then cli@k on the Network
windows.

If you are prompted to restart your computer, cl@sto restart, then begin
the Dial-Up Procedure.

2. Dial-Up Procedure

If the Dial-Up Networking window is not currently open, do the following:

Click the Windows 95/98tart button.

Click thePrograms option to display the Programs menu.

Click theAccessorieption to display the Accessories menu.
In Windows 95, clickDial-Up Networking

In Windows 98, clickCommunications, thenDial-Up Networking.

oo

The Dial-Up Networking window appears.
In the Dial-Up Networking window:

Double-click theFCC Auctions 800#icon if you wish to connect to the FCC Network
during the Mock Auction.

Double-click on thé=CC Auctions 900#icon if you wish to test your connection to the
900# that wi be used during Auction 33.

Note: If you connect to the FCC’s 900 number telephone service, there is a charge of
$2.30 per minute. The first minute of connection time to the 900 number service is at no
charge.

Click theConnectbutton on the windowDo not enter User name or Password.

The Connection window appears, indicating the status of your connection as your modem
dials into the system. This window must remain running during your dial-up session. You

may minimize the window, if you wish.

If your modem fails to establish a connection, please sebErdlubdleshootingsection
below.
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Once the connection is established, double-clickAtietion 33 Mock Auction Software
or Auction 33 Bidding Softwareicon.

When you have finished, exit the mock or auction software, then clidRisicennect
button on the Connection window to end your dial-up session.

E. Removing the Dial-Up Networking Service

Once you have finished using the dial-up networking service, you can remove it from your
computer, as follows:

1.

Click the Windows 95/9&tart button, then click th&ettingsoption to display the Settings
menu.

Click Control Panel and then double-click tHdetwork icon.

Highlight the TCP/IP Protocoland clickProperties. If there are multiple TCP/IP protocols,
highlight TCP/IP --> Dial-Up Adapterand clickProperties.

In a Windows 98 environment, a confirmation dialog appears. Read the information on the
dialog, then click th©K button.

Click theDNS Configuration tab.

Click the DNS Server Search Order box contaidif§.135.241.14%0 select it, then click
the Removebutton.

Similarly, click the DNS Server Search Order box contaiti®g.135.79.9%0 select it, then
click theRemovebutton.

. Click OK on the TCP/IP Properties windows, then clkK on the Network windows.

If you are prompted to restart your computer, cl@sto restart.

Remove thé=CC Auctions 800#icon from your desktop. That is, click the icon with your
right mouse button and then click tBeleteoption in the pull-down menu.

F. Troubleshooting

Following are problems you may encounter and possible solutions for resolving or isolating them.
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1. Modem does not respond

Confirm that all physical connections for the modem are present.

Confirm that the phone line is active by connecting it to a telephone and checking for a
dial tone.

If you are dialing the 900 number service, check for a 900 number telephone block. If the
volume settings are low, the modem may be dialing but not connecting. Check for this by
trying to connect to the 800 number, or by dialing the 900 number on that line using a
telephone.

Confirm that the correct modem driver is installed for your modem.

2. Modem dials but does not connect

If you are dialing the 900 number service, check for a 900 number telephone block.
Check for this by dialing the 800 number to see if you connect, or by dialing the 900
number on that line using a telephone.

Confirm that the number the modem is dialing is correct.

Confirm that the modem prefix, if any, is correct.

3. Modem dials and connects, but nothing appears when you enter the Location in the Web
browser

Verify the Dial-Up Networking settings specified in tBenfiguring Dial-Up Networking
section.

Confirm that your Web browser is not using proxies.

a) On your browser, click thBereferencesoption in the Edit menu.
b) In the Category area at the left, double-chakvanced

c) Click the Advanced structureRroxies option.

d) Click the radio button labelddirect connection to the Internet
e) Click theOK button at the bottom of the window.
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4. Receive a Null Object Reference error when starting the bidding software

Confirm that your dial-up networking and DNS configurations are correct.

5. Receive an Internal Server error in the Web browser

1. Confirm that thd_ocationis correct.

2.  Confirm thatJavaand JavaScript are enabled in your Web browser, and confirm that
Cookiesis set to Accept All.

G. Help

For technical assistance with installing or using FCC software, contact the FCC Technical
Support Hotline at (202) 414-1250 (V) or (202) 414-1255 (TTY). The FCC Technical Support
Hotline is generally available Monday through Friday from 7 a.m. to 10 p.m. ET, Saturday from 8
a.m.to 7 p.m. ET, and Sunday from 12 p.m. to 6 p.m. Al calls to the FCC Technical

Support Hotline are recorded.
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